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~ de meniuri, bara de acces

| (etichetele foilor de calcul).

LECTIA |,
1.1

ELEMENTE DE INTERFATA ALE UNEI APLICATII

DE CALCUL TABELAR

In urma parcurgerii acestui capitol, vei invita cum sa utilizezi aplicatiile de calcul tabelar. Cu acestea te
vei intdlni destul de des, atat pe telefon sau tableta, dar si pe calculator atunci cand vei dori si creezi si si
gestionezi aplicatii care utilizeaza tabele.

{ti vom prezenta in continuare cateva detalii si mici trucuri necesare in executarea unor calcule, si nu
putine, in utilizarea formulelor de calcul, in construirea diagramelor, in manevrarea tabelelor.

Nu va fi greu, este nevoie doar de atentia ta si lucrurile vor merge foarte usor.

Mult succes in noul an scolar!

Calculul tabelar, in general, este un program care pune la dispozitia utilizatorului un mare numir de
instrumente care pot fi manevrate cu usurintd. Este util si realizarii de diagrame, dar si realizirii bazelor de
date sau analizei de date.

Excel (pronuntat [ik'sel]), ca aplicatie a pachetului Microsoft Office, este un program
destinat, in principal, exact calculului tabelar. Documentele editate cu aceasta aplicatie sunt usor
de recunoscut dupa pictograma alaturat.

Numele documentului salvat, folosind Microsoft Fxcel, este urmat de extensia. x1sx.

Stiai ca...? l

¢ Numele intreg este Microsoft Excel.
& Formatul a fost . x1s, de la prima versiune pana la Excel 2003, devenind de la Excel 2007 .x1sx
(folosita in standardul international Office Open XML pentru documentele Office).
A aparut in 1982, initial sub denumirea de Multiplan, aplicatie dezvoltata de Microsoft.

TN

Pentru a deschide aplicatia Microsoft Excel, in functie de versiunea sistemului de operare instalat, urmiam
pasii Start - Microsoft Office > Microsoft Excel sautastim, in caseta de ciutare a sistemului
# de operare, Microsoft Excel. De cele mai multe ori, dupd instalarea pachetului Office, pe desktop existi
| pictograma programului Microsoft Excel.

La deschiderea aplica-
tiei Lxcel apare fereastra
alaturatd. Multe elemente iti
sunt deja cunoscute din
aplicatiile studiate in clasele
anterioare: bara de titlu, bara

rapid, panglica cu butoane.
Specifice aplicatiei  sunt:
caseta de nume, bara de
formule, zona cu denumirile




Imediat sub bara de titlu se afld bara de meniuri principale. Fiecare dintre acestea desfisoard meniuri pe
orizontald — Panglica de butoane (Ribbon).

BHS-e-m@an - ——

Bara de instrumente de acces rapid (Quick Access

Toolbar) poate fi modificatd conform preferintelor 3
utilizatorului.
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Celuke Editare

anizate pe grupuri: diferd de la un meniu la altul.

Stiai ca...? l

.
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® Pentru flecare optiune a meniului se poate folosi combinatia de taste scrisa in dreptul meniului.

® Putem folosi doar tastatura ca sa navigdm prin fiecare fila a meniului (ALT + litera
corespunzatoare).

Structura unui registru de calcul

Foaie de calcul

In programul de calcul tabelar, elementul principal este foaia de calcul, numitd worksheet sau, mai simplu,
Joaie (sheet). Putem privi foaia de calcul ca pe o foaie de hartie pe care se deseneazi, pentru inceput, un tabel.
Un fisier Excel contine una sau mai multe foi de calcul grupate intr-un registru de calcul (workbook).

La deschiderea unui registru de calcul, implicit apare un anumit numdr de foi de calcul, dar se pot introduce |

alte foi atunci cénd este nevoie. Foaia de calcul activi, cea in care se lucreazi la un moment dat, are eticheta |

evidentiat3 cu o culoare.

Daci este necesar, se poate face copiere sau mutare de foi de calcul 1n cadrul aceluiasi registru de calcul
sau chiar intre registre de calcul diferite (cu conditia ca acestea si fie deschise). Se executi click dreapta pe

eticheta foii de calcul ce se doreste copiatd sau mutati gi se alege optiunea Mutare sau copiere (Move
or Copy).

Mutare sau copiese

T Se‘ alege,ﬂ din meniul derulant,
In registrut fisierul in care se doreste
| Meith. et aioe j copierea sau mutarea foii de
Insirtes Foii: o
T TR AR caloul.
| Situntie

Se selecteazd, daca se doreste, imutare |5 s

0 copie a foii de calcul. Se apasa pentru finalizarea

| S actiunii.

{1 Crenres unei capii




W automat de citre Excel: Registrul (workbookl). Acesta se poate

LW

' Salvare ca (Save As). Alte modalititi: Ctrl+S, Alt+F2,

O altd modalitate pentru copierea in acelasi registru al unei foi de calcul: se executd click pe eticheta
acesteia, se tine apasat butonul stdng al mouse-ului, se apasé tasta Ctrl si se trage eticheta la locul dorit; se
elibereaza butonul mouse-ului si apoi tasta Ctrl:

| elevi | colegif2) | colegi (3) | medlii | colegi *

Foaia de calcul nou-creatd va avea denumirea foii sursd si un numar ce indicd duplicarea ei. Atentie!
Duplicarea foii de calcul nu se poate anula folosind butonul Undo (Ctrl+z, ).

Coloanad, rind, celuld, adresd de celuld

Zona de lucru este sub forma unui tabel impértit pe rdnduri si coloane. Unitatea elementard, aflati la
intersectia unui rand cu o coloani, in care se scrie un text sau o formuld, se numeste celuld. Aceasta se identifica
prin numele coloanei si al randului la intersectia cérora se afld. Astfel, coloanele se numeroteaza cu litere, A,
B, C..., 2, AA AB, .., iar rAndurile, cu numere naturale, 1, 2,... Asadar, celula identificatd prin A3 se afld la
intersectia coloanei A cu réndul 3.

In aplicatiile de calcul tabelar, asa cum am vizut deja, datele sunt organizate pe randuri (identificate prin
numere: 1, 2, 3,...) si coloane (identificate prin litere: A, B, C,...).

celula

e ~ activa

Identificarea unei celule se face prin folosirea unei adrese sau referinfe formate din litera coloanei si
numarul rdndului 1n care se afla celula respectiva. Celula activd (curentd) este indicatd printr-un chenar
ingrosat si are afisaté referinta in caseta de nume (in figurd, se poate observa ci celula activi este B3).

Operatii cu un registru de calcul

= Deschidere, inchidere, salvare, creare

La crearea primului figier, inainte de salvarea lui, denumirea este data

. . . . - .. " ™ Nou
redenumi, prin operatia deja cunoscutd de salvare, Fisier (File) -

L Desctndere

Intormatic

Sahare

Shift+F12, butonul Salvare (Save) A . Dacé se doreste salvarea

intr-un folder nou, se foloseste butonul Folder Nou (New Folder). el
In anumite situatii, cdnd figierul contine date confidentiale, se poate mstrumente > | Sohare |
aplica o parold, ca masurd suplimentard de securitate: butonul SH"V “b""“' 42 W
. . Optiun ¥eb.,.
| Instrumente din fereasta de dialog Salvare ca. Optiuni genetsie.
Atentie, insa, parola nu trebuie uitatd de utilizator! Camprimare imagini..

Un registru are, la inceput, un anumit numar de foi de calcul, etichetate
Foaiel (Sheetl), ..., in functie de versiunea Excel instalata. In versiunea | Foaiet | @
2019, registrul contine la deschidere o singura foaie de calcul.




Dupa terminarea lucrului intr-un fisier Excel, pentru inchiderea registrului de calcul curent si pentru
parasirea programului, se foloseste Fisier - Inchidere. Asa cum stii deja de la celelalte aplicatii

Microsoft invatate anterior, putem folosi butonul din coltul dreapta sus al ferestrei .

Sub bara de butoane sau instrumente, se gaseste, in
partea stingd, casefa de nume. Aici, este afigati ultima
celula selectatd sau coltul din stAnga sus al unui domeniu
de celule (adicé a unei zone din foaia de calcul formati din
mai multe celule care, la un moment dat, suporti o aceeasi
prelucrare) dacd se selecteazd un domeniu. Imediat 1ang3,
in bara de formule, apare continutul celulei active.

L) B C

—1

SR TSR R .
| - . o

Aceastd bard se modifica in functie de calculele care < . R
se fac in tabel prin intermediul formulelor. Si caseta de TEonch
nume se modificd in aceasti situatie, in locul ei apirind o S
listd derulanta cu functiile predefinite; continutul celulei va | 7] 2 s 7
arata formula utilizata.

Operatii cu foi de calcul

Accesare, redenumire

Foile de calcul pot fi accesate cu un click direct pe eticheta (numele) lor.

| Foaie! | Foaie2 | Foaie3 ®

Intr-o singuri foaie de calcul pot fi scrise foarte multe date, totusi se recomanda utilizarea mai multor foi
de calcul. Indiferent de numarul acestora, registrul de calcul este considerat a fi un singur fisier.
Numele prestabilit pentru o foaie de calcul este Foaiel (Sheetl), ... Existd mai multe posibilititi pentru
redenumirea acesteia.
o dublu click pe numele ei;
o click dreapta pe numele ei, apoi Redenumire (Rename);
o Fila Pornire - Format - Redenumire Foaie (Rename Sheet).
Numele vechi va fi evidentiat si inlocuit imediat ce se tasteazi cel nou. ,
Se pot adauga foi de calcul in plus fata de cele existente la inceput prin apisarea butonului Foaie

o | . . . - A . . O Ve - - - B .
noud j sau Shift+F11. Noile foi se adaugi 1n ordinea inserdrii, adicd, dacd se adauga Foaie5 si apoi
se sterge, urmatoarea foaie noud addugati va fi Foaie6. Fiecare foaie noud se insereazi la dreapta celei active.

Eliminarea unei foi de calcul se realizeaza prin click dreapta pe numele ei, apoi Stergere (Delete).

Atentie! Stergerea este definitivi, deoarece butonul Undo (Ctrl+Z, [l|) nu are niciun efect in acest caz.
Ascunderea unei foi de calcul se realizeazi prin click dreapta pe numele ei, apoi Ascundere (Hide).

Atentie! O foaie ascunsd nu mai este vizibila in registrul de calcul. Reafigarea ei se face prin acelasi procedeu, A
si anume click dreapta pe numele unei foi, apoi Reafisare (Unhide). Atentie! Butonul Undo §

(Ctrl+z, ) nu are niciun efect In acest caz.

Daca este necesar, foile se pot reordona astfel incat fiecare foaie sd se afle in pozitia doritd in cadrul
aceluiasi registru de calcul. Se executi click pe eticheta ei, apoi se trage In noua pozitie.

O foaie de calcul poate fi evidentiata cu o culoare; astfel, atunci cAnd nu este activi, aceasta este remarcati
mai usor. Procedeul este similar oricérei operatii aduse unei foi de calcul: click dreapta, apoi Culoare

selector (Tab Color) .




peratii registru de caleul:

Operatie Modalitate
Creare registru nou e Fisier (File) - Nou (New) > alegem un tip de sablon =
Creare (Create)
e TFolosind doar tastatura: CEr1+N (New)

Deschidere registru existent e Fisier(File) > Deschidere (Open)
e Folosind doar tastatura: CTRL+O (Open), apoi selectam registrul

dorit.
Deschiderea si vizualizarea Se repeta pasii precedenti pentru fiecare registru.
mai multor registre de calcul Vizualizare (View) > Fereastra (Window) 2>

=N

| e —
| [ Vizuslizare aléturate | ; Comutare |

S=—a 1y ferestre~ |

Salvare registru e Fisier (File)-> Salvare
e Folosind doar tastatura: CTRL+S (Save)

Daca fisierul nu are deja un nume, adicd este la prima salvare, se poate alege
Fisier (File) - Salvare ca (Save As) si i se dd un nume.

Salvare registru sub un alt Fisier (File)-> Salvare ca (Save As)
nume, un alt format sau o altd ~ Se redenumeste registrul, apoi (la alegere) Save as type, se selecteazd

locatie formatul (.zxt, .xIs, .pdf, html, xlr).
Creare copie registru curent

Inchidere registru e Fisier - Inchidere (Close)
Inchidere aplicatie s Prin butonul 1 situat in coltul din dreapta sus (A1t+F4).

Deschide aplicatia de calcul tabelar Microsoft Excel.

2. Salveazi registrul cu numele § si cu extensia .x/sx.

3. Redenumeste prima foaie de calcul elevi.

4. Adauga doua foi de calcul. Redenumeste-o pe a doua colegi.
5. Evidentiaza cu o culoare, la alegere, a doua foaie de calcul.
6. Ascunde Foaie3 din registru.

7. Insereazi o noud foaie de calcul. Mut-o pe prima pozitie. Redenumeste-o medii.
8. Salveaza registrul cu numele opt, cu extensia .pdf.

9

. Adaugi in bara de acces rapid butonul Sortare crescdatoare (Sort Ascending).

10. Ascunde (minimizeaza) panglica. Retine combinatia de taste!

11. Readu panglica in fereastra.

12. Modificd Zoom la 115%.

13. Modifica parametrii de salvare astfel incét sa se facd automat la fiecare /0 minute.
14. Reafiseaza foile ascunse din registru.

15. Salveazi si inchide atat registrul, cat si aplicatia.




Evaluare

Rezolva urmatoarele sarcini:

Exemplu:

Cum se creeazi un nou registru atunci cand este deschisa aplicatia Excel?
Rdéspuns: Se apasa Ctrl+N sau Fisier - Nou.

1. Cum salvezi cu un nou nume un registru in Excel?

2.  Cum redenumesti o foaie de calcul?
3. Bifeaza raspunsul corect.
Poti evidentia printr-o culoare numele unei foi de calcul?
O Da
O Nu

4. O modalitate prin care poti adduga o noua foaie de calcul intr-un registru este urmatoarea:

. . (11 Vizualizare alaturat
5. Descrie pentru ce poate fi folosit butonul A

6. Bifeazd rdspunsul corect.
Ascunderea unei foi de calcul are ca efect stergerea ei definitiva din registrul din care ficea
parte.
O Da
d Nu
7. Asociaza figurile din coloana A cu cele din coloana B:

coloana A coloana B
5 |coloand | a) L2
R Cosct numel) b Al
3) Salvare U’Ctrlf?l [ ) !__JS v
4  \Fosic &noui) o DR ]
e) £ _|

8.  Incercuieste litera corespunzdtoare rdaspunsului corect.

Butonul marcat in figura ma are rolul:

a) Optiuni de afisaj panglica |.
= i : L=
b) ‘F‘art:-.:ulan:are bara de instrurnente Acces rapid ‘

c) [Minimize]

9.  Incercuieste litera corespunzatoare rdaspunsului corect.
B8, ca identificator de celuls, semnifici:

a) B: eticheta de coloana, 8: eticheta de rand;
b) B: eticheta de rand, 8 eticheta de coloani; -
c) B: numele registrului, 8: eticheta foii de calcul. ;

Din oficiu: Ip.




i ului peste toate celulele din grupul dorit. Toate celulele selectate

| click.

LECTIA
1.2
OPERATII DE EDITARE

In continuare, vei afla cum poti edita elementele foii de calcul: celuld, coloana, rand.

Selectare

Selectarea unei celule se poate face in mai multe moduri. Cel mai simplu, este sd executi c/ick in celula
doritd. O alta modalitate, pe care o poti folosi mai ales daca celula dorita nu este vizibild in zona de lucru, este
sa tastezi coordonatele celulet in caseta de nume (de exemplu, daca scrii S43 in caseta de nume si apesi
Enter, s¢ activeaza celula S43).

Cum faci daca doresti sa selectezi mai multe celule? Foarte
simplu. Daca celulele sunt adiacente, cu ajutorul mouse-ului,
apasand butonul stiang si tinand apasat, deplasezi cursorul mouse-

™ =s

4 h BN b

vor avea un chenar verde.

La fel de usor, tastezi in caseta de nume domeniul de celule 52:05 P

| pe care doresti sa le selectezi, sub forma coltul stanga sus : coltul Eidl G ¢ b

dreapta jos si apoi apesi Enter. in figura, s-a selectat domeniul
de celule B2 :D5. Dupa apasarea butonului Enter, in caseta de
nume ramane scris doar coltul din stinga sus, de exemplu B2.

TR -

Dacd celulele nu sunt adiacente, apesi tasta Ctrl, iar cu
ajutorul mouse-ului, selectezi fiecare celula dorita. Toate celulele
selectate vor avea un fundal gri.

W B W e
|

Renuntarea la selectie se face executand c/ick oriunde in zona

de lucru.
. N | 4|E0R 5 ¢ b
Selectarea unui rand Intreg se realizeaza prin pozitionarca 1]
cursorului mouse-ului la capatul randului ce se doreste a fi =
. A a A . 3
selectat (pe eticheta de rand) si executarea unui click. Z = —_—

Daci doresti selectarea mai multor randuri adiacente, selectezi eticheta primului rand dorit, tii apasatd

\ tasta Shift si selectezi eticheta ultimului rand dorit in selectie. Sau, tindnd apdsat cursorul mouse-ului, il

tragi peste etichetele tuturor randurilor dorite. !,

Selectarea unei coloane intregi se realizeazd prin
pozitionarea cursorului mouse-ului deasupra coloanei ce se
doreste a fi selectatd (pe eticheta de coloand) si executarea unui

LY S TR

Daci doresti selectarea mai multor coloane adiacente, selectezi eticheta primei coloane dorite, (i1 apasatd
tasta Shift si selectezi eticheta ultimei coloane dorite in selectie. Sau, tindnd apasat cursorul mouse-ului, il
tragi peste etichetele tuturor coloanelor dorite.
| Daci doresti selectarea mai multor randuri neadiacente, selectezi eticheta primului rand dorit, tii apdsata
| tasta Ctrl si selectezi eticheta randurilor dorite in selectie. Se procedeaza asemanitor pentru selectarea mai
multor coloane neadiacente.




Pentru selectarea simultand a unui rand si a unei coloane, se

tine apdsatd tasta Ctrl si se selecteazd cu mouse-ul randul si | = -
coloana dorita. ; .

555

Pentru selectarea intregii foi de calcul, executi click pe
cisuta din coltul din stdnga sus al foii de calcul, cisuta care
contine un triunghi (cursorul isi schimba forma, ) sau apesi
tastele Ctr1+a (selectare totald).

Exemple:

pentru selectarea coloanei B din foaia de calcul, se tasteazi in caseta de nume B: B ;

pentru selectarea tuturor coloanelor adiacente de la B 1a D din foaia de calcul, se tasteazi in
caseta de nume B:D;

pentru selectarea tuturor coloanelor adiacente de la B la D si a coloanelor adiacente de la H
la K din foaia de calcul, se tasteazi, in caseta de nume, B:D, H:K;

pentru selectarea liniei 3 din foaia de calcul, se tasteazi, in caseta de nume, 3: 3 ;

pentru selectarea tuturor liniilor adiacente de 1a 3 la 5 si a liniilor adiacente de la 8 Ia 12
din foaia de calcul, se tasteazi, in caseta de nume, 3:5,8:12.

Copiere, mutare, stergere

Tnainte de a copia, muta, sterge randuri sau coloane, este necesara selectarea lor, procedeu invitat anterior. |
Asa cum stim din clasele anterioare, se foloseste combinatia de taste Ctr1+C pentru copiere, Ctrl+X pentru
mutare, Ctr1+V pentru lipire.

Operatiile acestea pot fi realizate si executind click dreapta oy M
pe eticheta randului/coloanei selectate si alegerea optiunii dorite, : L] B -
apoi lipire in pozitia noud. De asemenea, se pot folosi si Lipire
butoanele bine cunoscute din fila Pornire (Home), grupul de | I
butoane Clipboard. RO

In ceea ce priveste lipirea (inserarea) continutului care se doreste a fi adus din Clipboard in foaia de
calcul, existd mai multe optiuni:

¢ ]

X - = <
L_f- Formule L Pistrare formatare sursi
| e 1 b

L’
| % | 3 123 !
‘ Formule §i formatare numere Valori
[ i
T‘ . .
Pastrare latime coloani sursa = I valeri si formatare numere 3
- ot
123 | Valori si formatare sursi




